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Publisher 2000 

Microsoft Publisher 2000 is an easy-to-use desktop publishing program that helps students and 
teachers create eye-catching newsletters, flyers, brochures, programs, and Web sites.  Publisher 2000 
complements writing and learning activities in your classroom, and can help you expand the 
visibility of your school events and activities.  

Publishing is a necessary, final stage of the writing process.  It gives students the opportunity to 
further develop their personal styles, reach out to an audience, and acknowledge their own work.  
Desktop publishing with Publisher 2000 moves publications beyond word processing and helps you 
and your students create professional, distinctive publications without any design experience.  
Publisher 2000 lets you and your students focus on creativity, instead of learning how to use 
software. 

In this booklet, you can learn about Publisher 2000 by doing the following: 

• Use a wizard to create a publication. 

• Use the Design Gallery to change layout. 

• Insert text and graphics into frames. 

• Edit text and check spelling. 

• Add interest to the newsletter with a Drop Cap. 

• Add or delete pages. 
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 New for 2000 

Whether you are new to Publisher2000 or are already familiar with it, the new features will make it 
easier than ever to create eye-catching publications: 

• Improvements and additions to Publisher 2000 have made it even easier to learn and use. 

• Publisher 2000 looks and works like Office 2000.  The most obvious similarities include the 
familiar menus and toolbars.  You can also add automatic bullets and numbering to your 
publications, similar to Word and Excel documents.  The File Open/Save feature is common 
to all Microsoft programs and themes are shared across Office so your Word documents, 
PowerPoint presentations, and Publisher 2000 publications all share a consistent look and 
feel. 

• Publisher 2000 has made it easier than ever for you to get professional looking results 
without professional design expertise. 

• Quick Publication Wizard, Catalog Wizard, and 400 new publication templates have been 
created by professional designers.  Flip Graphics and the Advanced Editing Toolbar help you 
add even more design elements. 

• Publisher 2000 is your complete publishing solution.  

• Publisher 2000 publications can be printed to your black and white or color desktop printer, 
taken to a copy shop, or taken to a commercial printer, and printed just as more 
sophisticated publications are.  New features for publishing include: 

• Pack and Go Wizard which makes it easy to pack a publication across multiple diskettes 
(including fonts, graphics, and text) for easy travel to a copy shop or commercial printer.  

• New commercial printing support includes automatic conversion to spot or 4-color Process 
(CMYK) with automatic color separations.  

• Support for PANTONE® colors, Color Matching, and device independent layout.  

• All of these features make it possible for you to create professional caliber publications. 
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 Exploring The Publisher2000 Window 

With the Publisher Quick Publication Wizard, you can create a layout for your quick publication.  
You can now modify a publication on your own with Publisher 2000 tools, or you can return to the 
wizard and make any global changes to the publication—modify the Design, Color Scheme, Page 
Size, or Layout—without disturbing the content, or you can use Publisher 2000's other wizards.  
Take a moment to explore the elements of the Publisher window. 

Publisher  
Rulers  Publication main window 
 

 
Toolbars 
 
 
 
 
 
 
Wizards 
 
 
 
 
 
 
Wizard  
options 
 
 
 
 
 
 
 
Page icon 
 
 
Show/Hide 
Wizard 
 

 

Depending on your publishing needs, skills, or experience, you can choose to modify your 
publications using the Publisher tools and toolbars.  Each publication type also has a unique set of 
wizards.  More complex publications, such as newsletters or catalogs, have more wizards than 
simpler publications, such as business cards and letterhead.  You'll find the wizards located in the 
left pane of the screen.  They are available to you any time during the design process.  ScreenTips 
and the Office Assistant provide additional help and are described in the pages to follow. 
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The Formatting toolbar contains buttons that change according to what the type of frame you have 
selected (text frames for text editing, picture frames for picture editing).  Each button acts on the 
text or object you select. 

Drop-down lists used to    Buttons used to underline, 
format font type and size.   italicize, or bold text. 
 

 

 
These fields show position, size, and angle of 
rotation of graphics and allow you to make precise 
adjustments.  

 These fields show position and size of 
text and line spacing and allow you 
to make precise adjustments. 

The Measurements toolbar contains buttons that give you the ability to do more precise higher-end 
work.  The Objects toolbar is located on the left side of the screen and can also float on the screen.  
You can also place it with other toolbars.  The Objects toolbar contains buttons that help you create 
frames, place objects, and format for the Web.  

Selects the 
Pointer 
Tool. 
 

 Creates a 
WordArt 
frame. 

 Buttons used to 
create custom 
lines and 
shapes. 
 

 Use to select 
objects from 
the Design 
Gallery. 

 
 
Used to 
create Text 
and Table 
Frames. 

  
Used to create 
Picture frames 
and insert items 
from the Clip 
Gallery. 

  
Used to work on Web 
sites for greater 
flexibility. 

Format  Format numbering, Increase or 
paragraph  bullets, and decrease the 
justification. indentation. font size. 
 

Format text Select fill and View    Rotate  
wrapping  line color, and line frame    objects. 
around graphics. formatting style. properties. 
 

Link text frames and 
flow text from one 
frame to the next. 
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 Creating A Publication 

This lesson introduces you to the basics of Publisher 2000 while you use a wizard to create a 
newsletter.  Creating a school newsletter with Publisher 2000 helps you organize text and graphics.  
You can use a newsletter to communicate information and ideas to students or to the community.  
Your students can use the newsletter to develop skills in acquiring information, organizing it, and 
communicating it to others.  Once you have learned how to use the Newsletter Wizard, you can use 
the same skills to create publications using any of the other wizards. 

Exploring the Publisher 2000 Catalog 
When you open Publisher 2000, the Publisher Catalog appears on the desktop.  The Publisher 
Catalog is a visual directory of publication designs.  It appears each time you start Publisher 2000.  
You can use the Publisher Catalog to open existing publications or create new ones:  

• Select the Publications by Wizard tab to create personalized publications using wizards.  

• Select the Publications by Design tab to create a set of publications, such as letterhead, 
business cards, and a brochure, all with a common design theme. 

• Select the Blank Publications tab to create a publication without using wizards. 

• Click Existing Files to work on files you have already created. 

Designing with the Newsletter Wizard 
The Publisher 2000 Newsletter Wizard helps you create a professional looking layout for your 
newsletter.  The Newsletter Wizard takes you step-by-step through the design process by asking you 
questions about layout, color scheme, and printing.  

This lesson guides you through creating a four-page newsletter with your own articles.  You will be 
able to add pages with various layout designs and add graphics with captions that enhance your 
articles. 
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To use the Newsletter Wizard 
1. If the Microsoft 

Publisher Catalog is 
not visible, click the 
FILE>New menu. 

2. Click the 
Publications by 
Wizard tab.  

3. In the Wizards pane, 
click Newsletters. 

4. Click Blends 
Newsletter and then 
click Start Wizard.  

5. If you are presented 
with the “Personal 
Information” dialogue 
box, fill in the 
primary information 
with information about your school site. 

6. Read the introduction and then click Next. 

7. Select Mountain and then click Next.  

8. Select the 2-column option and then click Next. 

9. Select the “No” for customer’s address option and then click Next.  

10. Select the Single-Sided option and then click Next.  

11. Select the Primary Business option. 

12. Click Finish.  

13. Save your newsletter by clicking on the FILE>Save menu. 

14. Click on “Hide Wizard”. 

 

Personal, School, or 
Business Information 
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Customize Your Newsletter 
Now that you've created the basic newsletter layout, you can drop in headlines, articles, and clip art 
to customize your newsletter. 

To enter information on the first page of your newsletter 
1. Zoom in on the publication in one of the following ways: 

• On the Standard toolbar at the top of the screen, click the 
plus sign (+) to zoom. 

• Click the Zoom box next to the plus and minus signs and then select a magnification 
from the list. 

• Press F9 to zoom-in to 100% or zoom out to fit the screen. 

2. Click the placeholder text "Newsletter Title" and type Marine Mammals Newsletter.  If 
AutoFit is activated, the text gets smaller as you type to fit in the text box. 

 

3. Click the placeholder text "Newsletter Date" in the upper-right 
corner of the newsletter and insert the current date by using the 
INSERT>Date and Time.  

4. Click the placeholder text "Lead Story Headline" and type 
Harpooning of Whales Causes Controversy for the title of the lead 
story. 

 

5. Click the placeholder text below the Lead Story Headline.  Delete the text in the story 
columns. 

6. Launch Microsoft Word.  Open the document in the tutorials file labeled “Harpoon.doc”.  
Highlight the entire Word article and copy it to the clipboard.  (EDIT>Copy or Ctrl+C) 
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7. Return to Publisher and make sure your cursor is still in the lead story area.  Paste the story 
from the clipboard into the frame from Word (EDIT> Paste or Ctrl+V).  If the text doesn’t fit, 
you can edit it or change the font to a smaller point size. 

8. Select and delete the lead story graphic.  Select INSERT>Picture> From File.  Insert the 
picture labeled harpoon.jpg.  You may have to resize the image to fit in the space provided. 

 

9. Click the text "Secondary Story Headline" and type Whale Habitat. 

10. Select the text in the columns and delete it.  Open the Word document in the tutorials file 
labeled “Habitat.doc”.  Highlight the entire Word article and copy it to the clipboard.  
(EDIT>Copy or Ctrl+C) 

11. Return to Publisher and make sure your cursor is still in the secondary story area.  Paste the 
story from the clipboard into the frame from Word (EDIT> Paste or Ctrl+V).  If the text 
doesn’t fit, you can edit it or change the font to a smaller point size. 

 

12. On the FILE menu, click Save to save the changes you have made to the newsletter. 

To enter information on the inside of the newsletter 
1. To go to the second page of the newsletter, click the 

page icon with the number 2 at the bottom of the 
Publisher window.  You should see a page icon for 
each of the pages currently in the newsletter. 

 

Page 10 pub2000.doc 
 



 Microsoft Publisher 2000 
 

2. On the Newsletter Wizard in the left pane, click Inside Page Content.  The Inside Page 
Content wizard allows you to change the layout of the page to accommodate the information 
types you may want to add to the newsletter. 

 

3. In the lower-left pane, click the Calendar with 1 story option. 

4. Click on the page three icon. 

5. Click the Response form with 1 story option.  The page now has one story and a form that 
can be used to add questions about the articles found in the newsletters. 

6. On the File menu, click Save to save the changes you have made to the newsletter. 

7. Pages two and three should look something like the following: 
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Zooming to Change the View 
In Publisher 2000, viewing text and graphics is easy when you increase and decrease the 
magnification of the image on screen with Zoom mode.  Located on the Standard toolbar, Zoom shows 
the current magnification of your page.  The percentages for increasing and decreasing the size of the 
image are preset.  This does not change the actual size of the image.  There are four ways to change 
the view: 

• On the Status Bar, click the Zoom drop-down box next to the plus 
and minus signs and then select a new view. 

• Click the plus sign (+) on the Status Bar to increase the magnification (view size) of the 
newsletter up to 400%. 
- Or - 
Click the minus sign (-) on the Status Bar to decrease the view size to as small as 10%. 

• On the View menu, click Zoom and select a new view. 

• Right-click on the publication and then click Whole Page, Page Width, Actual Size, or 
Selected Objects. 

• Click an object in your publication.  Press F9 to zoom in or out to 100%. 

Adding or Deleting Extra Pages 
The newsletter you created may contain fewer or more pages than you'll need.  Adding and deleting 
pages is simple.  If you need six pages to fit the content in your newsletter, follow the instructions for 
adding extra pages.  If you need only two pages to fit the content in your newsletter, follow the 
instructions for deleting extra pages. 

To add extra pages 
1. To go to the fourth page of the newsletter, click the page icon with the number 4, which is at 

the bottom of the Publisher window. 

2. On the INSERT menu, click Page.  The Insert Page dialog box appears. 
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3. In the drop-down box, select the layout you want for the page. 

4. Click the “More Options” button to enter the number of pages you wish to insert and whether 
you wish to insert them before or after the current page. 

5. Click OK to add a new page. 

To delete extra pages 
1. Now that you’ve successfully added a page to your newsletter, we’ll delete pages 4 and 5.   

2. Go to the fourth page of the newsletter; click the page icon with the number 4, which is at the 
bottom of the Publisher window. 

3. On the EDIT menu, click Delete Page. 

 

4. Click OK to delete the page. 

5. You will get a notification box to let you 
know that the objects that were on that 
page can be deleted or moved to another 
location. 

6. Notice that page 5 has now become page 
4. 

7. Repeat steps 2, 3 and 4 to delete the new 
page 4. 

Add Two New Articles to Your 
Newsletter 
On pages 2 and 3, there is now space for two more 
articles.  In your tutorial folder, you will find two 
more articles to be inserted into our newsletter.  
Follow the steps outlined earlier on completing 
page one of our newsletter. 
 

1. On page two, insert the article labeled “humpback.doc” and give the article a headline. 

2. On page three, insert the article labeled “blue.doc” and give the article a headline. 

3. On page three, insert the picture of the Blue Whale from the tutorial folder.  The graphic is 
labeled “bluewhale.jpg”.  We’ll add a caption later. 
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4. On page two, we will insert a piece of clip art into the Humpback article.  From the Insert 
menu select PICTURE> From Clip Art.   

5. When the Clip Art Gallery opens, type the word “Whale” in the Search text box and the top of 
the window and press the ENTER key.  All of the pictures containing the keyword Whale 
will appear. 

6. Select the clip pictured here and insert it into 
your newsletter.  Place the clip art between the 
two columns. 

7. Using the “Rotation” tool, rotate the 
whale counter-clockwise so that it 
looks as if the whale is diving. 

 

Enter Captions For Graphics 
No matter how good an illustration is, a caption can tell the readers even more. In the newsletter, 
each of the picture frames also has a caption frame attached.  You can also insert caption frames in 
the publications. 

To add or change the caption 
1. Click anywhere on the text "caption describing picture or graphic" below the lead story 

graphic to select the text. 

2. Zoom in to get a closer look at the caption. 

3. Click in the caption box below the picture of the harpoon displayed in the lead story. 

4. Type a sentence describing the significance of the graphic or picture to the lead story.  “Early 
Harpoon Construction.”  You can adjust the font and size as well. 

5. Click outside the Text Frame.   

6. Click on the page three icon and locate the blue whale graphics we inserted earlier.  Move 
the graphic to the right hand column. 
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7. To add a caption, start by clicking on Tools on the menu bar and clicking on “Snap to 
Objects”. 

8. On the objects toolbar, generally docked on the left hand side of your screen, 
click on the Text Box button.  Draw a caption box just below the picture of the 
blue whale. 

9. In the caption box type: “The Great Blue Whale”.  Bold 
and center the caption within the caption text box 
using the bold button and the center justify button. 

10. Next you will join both the image and the caption box 
together – something called “Grouping” objects.  Click 
once on the caption text box hold down the SHIFT 
key and click once on the whale image. 

11. Click on the puzzle piece at the bottom of the selection 
to group them together.  

12. Press F9 to zoom out to see the whole page again.   
 

Inserting A Drop Cap 
Sometimes a fancy first letter (called a drop 
cap) in a paragraph catches the reader's 
attention.  The drop cap can also help fill a 
page that does not have a lot of text.  In order 
to perform this task, you must already have a 
story in the text frame.   

   Drop cap 
 
   Article  
   or story 
 

To insert a drop cap 
1. Go to the lead story on the page 1 of the newsletter. 

2. Click in the lead story text frame on the first 
paragraph.  If you have been falling behind, talking 
to a friend or asleep, and have not already added a 
story in this text frame, then add at least one line of 
text before continuing. 

3. On the FORMAT menu, click Drop Cap. 

4. Click the Drop Cap tab, if necessary, and then click 
one of the drop-cap options in the Available drop 
cap box.  You can scroll in the Available drop cap 
box to see additional drop-cap options. 

5. Click OK to add the drop cap you selected. 

6. If you would like to try other drop cap styles, go ahead and add drop caps to the other articles 
in this newsletter.  (Knock yourself out) 
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Checking Spelling 
Publisher 2000 includes some of the same features found in Microsoft Word, including background 
spell checking.  

To check spelling 
1. If you misspell a word or Publisher 2000 does not recognize it, a red wavy line appears 

directly beneath the word on the screen.  Right-click the underlined text to see suggested 
options.  

2. You can select a correction, add the word to the dictionary, or tell Publisher 2000 to ignore all 
instances of the word. 
-Or- 
Publisher 2000 also has the spelling option on the TOOLS menu.  

3. On the TOOLS menu, point to Spelling and then click Check Spelling.  The spell checker 
checks one story at a time.  A dialog box appears at the end of the first story asking if you 
want to check the rest of the publication. 

4. Click OK to continue checking spelling.  The Check Spelling dialog box appears when a 
misspelled word is found.  You can change, ignore, or add the word to the dictionary. 

Fill out the Form and Links on Page Three 
On page three, we indicated that it should contain one story and a form.  The form can be used for 
any number of tasks.  The form can be used for surveys, ordering materials or, in our case, a review 
of the material contained in this newsletter. 
 
1. Click on the page three icon. 

2. Starting at the top of the form, select the form title and change it to “Marine Mammals”. 

3. Change the form title below the heading to “A Whale Of A Lot Of Questions”. 

4. In the instructions box type the 
following:  

Read the articles contained in 
this newsletter.  Take a few 
minutes to answer the 
questions below and turn them 
into your teacher.  You will be 
given credit for this Science 
and Mammals assignment. 
 

5. Review the illustration provided to 
complete the questions and 
checkboxes.  

6. There are several lines at the 
bottom of the form.  We will use 
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three lines only.  Delete the other lines by clicking on the line and pressing the Delete key. 

7. Click on each of the remaining lines and vertically space them equal distance apart.  (Alt+Any 
Arrow Key will nudge the line up, down, left, or right.) 

8. Add text boxes to each of the lines (or copy and paste the existing one).  Line one: Name, Line 
Two: Grade Level, Line Three: Teacher. 

9. Your completed form should look something like the following illustration. 

 

10. Change the information in the 2 for 1 box to reflect the following illustration. 
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Adding a Logo 
It would also be nice to have our logo placed in several strategic locations on our newsletter.  When 
you apply the logo it will be come part of your personal information that can be used in later 
publications. 
 
1. Under the links box, you will notice a graphic labeled “Organization”.  Click once 

on the graphic. 

2. You should see an icon at the bottom of the graphic that looks like a magic wand. 

3. Click once on the wand to get the logo dialogue box.  This dialogue box is used 
to create a logo or get an existing logo from either Publisher or other source. 

4. In this case, select “Image I Already Have” and click on the “Insert Picture” 
button.  Navigate to the Publisher tutorial folder for this lesson and select the 
image labeled “CompanyLogo.jpg”. 

5. The logo should now appear in the space below the Links box. 

6. Click on the page two icon to go back to the calendar page.  Place your cursor 
in the space below the calendar. 

7. From the Insert menu, select “Personal Information” and select “Logo” at the 
bottom of the menu.  The logo will appear in the space at the bottom of the calendar.  You can 
resize the logo just like any other graphic by clicking the lower left corner and dragging it out or 
in. 

Inside This Issue Box 
Return to page one by clicking on the page one icon at the bottom of the screen.  Enter the article 
names and page numbers into the “Inside This Issue” box.  

Add a Poem to the Sidebar 
Next we’ll add information into the sidebar on page one.  You can enter any information into this 
sidebar that you wish.  If you wish, you can open the “WhalePoem.doc” document in your tutorial 
folder and insert it into your sidebar or you could add a piece of clip art.  You choose. 

The Final Product 
Check out the next several pages to see an illustration of the final product.  Yours, of course, may 
vary.  This is a fun way for presenting material in the classroom.  Once you have become proficient 
at developing these kinds of documents, let the student use this tool to design and present classroom 
research.  This looks great at Open Houses. 
 

Use Of Encarta For Research And Resources 
Use the Microsoft Encarta CD-ROM to assist in the research process.  Encarta contains a wealth of 
information on a large number of topics.  You may also cut and paste images out of Encarta into your 
newsletter and reports.  The Encarta material may be used to enhance the educational process and 
research based learning, but may not be published outside of the district. 
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